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EasyManager™ Features

EasyManager™ assists you to easily manage personal information and export/import the 
relevant information between other software programs. Some of the salient features of 
EasyManager are as follows:

· Manages information on people including family relationships, postal addresses, 
unlimited telephone/fax numbers, unlimited electronic mail addresses, date of 
birth, anniversaries and more [ referred as Person Object ].

· Lets you share home addresses and home telephone and fax numbers. You 
enter or update the home addresses or telephone numbers only once and 
EasyManager manages the consistency. See Living With and Working With 
attributes of Person Object for more information.

· Manages information on businesses including address, unlimited telephone/fax 
numbers, unlimited electronic mail addresses, and more [referred as Business 
Object].

· Lets you group Person and Business objects. You can make groups that contain 
other groups. A object can be part of many different groups [referred as Group 
Object].

· EasyList™ lets you view and edit objects as lists. You can create your own lists 
or modify existing lists so you can view and edit only the attributes of the 
objects that you want to.

· EasyEditor™ lets you view and edit all the attributes of one object at a time. 
This is the ultimate place to view and edit all the attributes of any Object.

· EasyLabel™ lets you create your own custom labels, view the label data, and 
print them on any size paper. You can also generate custom address books by 
simply printing the labels on plain sheet of paper.

· EasyFill™ lets you enter information by completing the partially entered 
information depending on the context.

· EasyLook™ lets you quickly look up information on a Person, Business or Group 
without having to search for it in EasyLists or in the EasyEditor.

· EasyExport™ lets you export data to ASCII files and to programs like on-line 
services including CompuServe, Spreadsheets, etc. If you have a favorite 
program that you want to export to and we don't yet support let us know. Go to 
feedback on how to contact us.

· EasyImport™ lets you import data from ASCII files and other applications. If you 
have a favorite program that you want to import data from and we don't yet 
support let us know. Go to feedback on how to contact us.

· Printing lets you print the data in any open EasyList in spreadsheet style.
· EasyFilter™ lets you filter Objects in a EasyList so that you view the information 

only of the objects that you want to. This feature is not yet available.



Overview of EasyManager

EasyManager assists you in managing personal information in many different ways. Before 
reading this section, please read the EasyManager Features.
Following are different types of objects that you can directly create, modify, view and delete.

· Person Object
· Business Object
· Group Object

An object consists of many different pieces of information associated with the given object. 
Each piece of information is considered as an attribute of the object. For example, every 
object has a name by which it is identified. Thus the object is said to have a name attribute. 
In general, you may not be interested in viewing all the attributes of the objects at one time.
In fact, you may want to group certain pieces of information (attributes) and view particular 
information of a particular type of object all at once. EasyLists let you view only the desired 
attributes of particular types of objects. For example, Person Telephone List displays only 
the home and work telephone numbers of Person objects.
A number of EasyLists have been predefined for your convenience to begin with. You may 
create new list definitions, may modify the definition of existing lists, or delete them if you 
do not need them. See Customizing EasyList for details.
You may edit any attribute that you can view in any EasyList. If a given attribute appears in 
more than one list, it is automatically updated to maintain consistency. 
You may select any one object in any EasyList. The selected object appears as a highlighted 
object within all the EasyLists that display it. The selected object is also displayed within the 
EasyEditor if the editor is open. See Selecting An Object on how to select any object. 
EasyEditor allows you to view and edit all the attributes of a given object. It changes its form
depending on the type of object that is being edited. 
You may create new objects either from within the EasyEditor, or within any EasyList. See 
Creating An Object on how to create new objects. 
You may delete any object by first selecting an object and then either selecting the delete 
menu item from the Edit menu, or by pressing Ctrl+D. Only a selected object can be 
deleted. See Deleting An Object on how to delete an object.
To improve user productivity, you may only enter partial information for many of the 
attributes, and the EasyFill facility will automatically complete the value. If the partial 
information that you enter does not resolve to any possible value, or resolves to more than 
one possible value, then you will be given a set of possible choices to select from.
By default, a given EasyList displays all the objects of a given type that the list is designed 
to display. You may choose to filter the objects that you view in the list by specifying a filter 
criteria by invoking EasyFilter from the EasyList. 
EasyManager maintains significant amount of information on a given object. You may export 
a portion of the information to other programs by invoking EasyExport. The number of 
programs that you can export information to keeps on growing. Currently, you may export 
relevant attributes of all objects in the database or only the objects in a given EasyList to 
CompuServe Address Book, and List Data as Tab or Comma separated text file (which you 
can then export to many other programs like Spreadsheets and databases). 



You may Print any EasyList. The list will be printed exactly the way you see it on the screen.
There are times when you want to quickly and easily see a particular information on a given 
object quickly. This is specially true of postal addresses, telephone numbers, and electronic 
mail addresses. You can do this easily by invoking EasyLook. EasyLook allows you to enter a 
name pattern, and it displays the requested information of all the objects that match the 
name.
EasyLabel allows you to create, view and print the labels. You can also print address books 
by simply printing the labels on a plain sheet of paper.



Future Features Coming Soon

EasyManager will be enhanced in future releases to do many more things. The idea is to 
make EasyManager as your preferred software to managing information from which you can 
then export it to other applications. This way you maintain consistency of data across many 
applications and the data is always available when you need it.
The following features are already under development. If you would like to have a particular 
feature that is not mentioned here, let us know. See feedback on how to contact us.

· Export objects to many other applications like Online Services, Fax, Electronic 
mail, Mail Merge, Calendar and Label Generator programs. If you use a favorite 
program which you want to export data to, let us know. See feedback on how to 
contact us.

· EasyFilter to filter objects that you want to see in EasyLists.
· EasyReminder to automatically remind you of the coming birthdays and 

anniversary days.
· DOS version of EasyLook to allow you to quickly lookup information at a DOS 

prompt without having to go to Windows.



Introduction To Objects

In general terms, an Object is said to be an encapsulation of certain pieces of related data 
and a certain behavior associated with that data. Human thinking and approach is object-
oriented. We see things in terms of objects and associate certain characteristics and/or 
behavior with these objects. 
EasyManager also models objects. There are three primary objects that you have direct 
control over their creation, deletion, modification and selection. These objects are:

· Person Object
· Business Object
· Group Object

Each of these objects represent an entity in our day-to day lives. Person object represents 
certain data of a person, and certain behavior is associated with it. For example, A Person 
may live with another person, persons have names, they are related to other persons, have 
a home and work address, and so on. Person objects are used to save personal information 
of friends, relatives, acquaintances, and so on.
Similarly, Business object represents an organization which has a postal address, phone 
number, electronic mail address. Business objects are used to store information on 
businesses. For example, you may want to store business information for your local drug 
store, associations, banks, shops, and so on.
In our day-to-day lives, we group set of related objects. The objects can be related in many 
ways. For example, we may group persons who live in a particular state - like all friends who 
live in California. The Group object is used to group Person, Business and other Group 
objects together.
There are many other objects within EasyManager that you do not directly have control over.
That is, you cannot independently refer to these objects. They exist only in the context of a 
primary object as mentioned above. These objects exists as long as the primary object to 
which they belong also exists. These objects are: 

· Postal Address Object
· Electronic Mail Address Object
· Phone Object

Postal address object has the street address, city, state, zip and country attributes. A postal 
address object is used to keep home and work address for Persons and address for 
Businesses.
Electronic Mail address object is used to keep electronic mail address, address type and 
additional comments. This object is used to keep electronic mail address of Persons and 
Businesses.
Phone object is used to keep phone numbers. It is used for home and work phone numbers 
and fax numbers of Persons, and phone and fax numbers of Businesses.



Person Object

Person object is designed to keep personal information of a person. The following 
information can be stored for any person.

Id

Name
Alias

Living With
Home Address
Home Telephone Number
Home Fax Number

Working With
Company Name
Work Address
Work Telephone Number
Work Fax Number

Email Addresses

Sex
Birth Date
Marriage Date

Father
Mother
Spouse
Children



Person: Id

Every object is identified internally by EasyManager with an id. Person objects also are 
assigned an id automatically as soon as the object is created. The id of an object is unique 
within a database.

See Also
Person Object.



Person: Name

Name is the primary attribute that is used to identify the person. You can define more than 
one person with the same name, but it is not advisable to do so as it may create confusion 
while exporting the object to other applications. When creating an object, if another object 
by the same name already exists, EasyManager will give you a warning.
It is advisable to enter the name with first name first, then the middle name if any, and then 
the last name.

See Also
Person Object.



Person: Alias

Alias is another name of the person by which the person may be identified. Normally alias is 
used to identify persons while exporting data to other applications. For example, when 
exporting electronic mail addresses in the UNIX .mailrc format, alias of the person is used to 
identify the person by default. If alias of the person is not specified, then the Name is used 
for identification.

See Also
Person Object.



Person: Birth Date

This is the date the person was born. You enter the date in MM/DD/YYYY format. See Editing 
Date Value on various ways to enter date values.

See Also
Person Object
Editing Date Value



Person: Marriage Date

This is the date the person was married. You enter the date in MM/DD/YYYY format. Editing 
Date Value on various ways to enter date values.

See Also
Person Object
Editing Date Value



Person: Sex

This attribute specifies the sex of the person. There are two possible choices, Male and 
Female. 
You can use the EasyFill feature to enter the value. i.e. you only need to type enough 
number of character to identify the value uniquely. In this case, you need to only type f or F 
and press return for Female and type m or M and press return for Male.

See Also
Person Object 
EasyFill 



Person: Living With (Share Home Address With)

This attribute is used to denote if the given person is living with another person. A person is 
said to be living with another person if he/she shares the home address with that person.
If the person is living with another person, then you may want to specify the name of the 
person with whom this person is living with. This way the home address and (optionally 
home telephone and fax numbers depending on the Preferences) are shared between all 
the persons living together. When you change the home address of one, the change is 
reflected for all the persons living together. This helps in eliminating redundancy in 
information, and at the same time automatically maintain data consistency. 
EasyFill feature is active for this attribute. You need to only type in enough number of 
characters to identify the name uniquely. The EasyFill feature will be complete the name for 
you. If you type in the name which matches more than one person's name or does not 
match any name at all, a selection box will be displayed for you to make a choice.
Detailed Explanation
Normally, at a given home address, there is one person who is designated as the primary 
person who is said to be living there. Rest of the persons live with the primary person. You 
would select any one person amongst all the person who are living at the given home 
address to be the primary person. Typically, the head of the household will be the primary 
person with whom rest of the persons (like spouse, and children) will be living with. So the 
head of the household does not live with anyone, but others live with him or her. 
You can change the primary person with whom rest of the people are living with by making 
the primary person live with someone else who is living there.
For example, lets say Jane, Bill and Mike were living with Joe. That means that Joe is the 
primary person living at the given home address, and the Living With attribute is empty for
Joe. Now, lets say you make Joe live with Jan. Then automatically Bill and Mike will also be 
updated to live with Jane and Jane will become the primary person living at the given home 
address. 
As another example, lets say Jane, Bill and Mike were living with Joe at a given home 
address. Now, if Joe is then edited such that Joe now lives with Andy the following action will 
take place. 

· If Andy was already living at a given address, then Joe, Jane, Bill and Mike will 
also have the same home address as Andy. 

· If Andy's home address was not yet specified but you have already specified the
address of Joe (or Jane or Bill or Mike), then Andy will also share the same home 
address as Joe, and will also become the primary person living at that home 
address. 

See Also
Person Object 
Person: Living Together

EasyFill
Preferences Dialog



Person: Living Together

This is a read-only attribute which is automatically updated to show who all are living with 
the given person. This attribute is obsolete, and cannot be viewed or accessed by the user.
See Also

Person Object 
Person: Living With



Person: Home Address

This attribute specifies the home address of the person. See description of Postal Address to 
understand different attributes that completely specify a home address. 

See Also
Person Object 
Postal Address 



Person: Home Telephone Numbers

This is a set of telephone numbers of the person. You may specify as many telephone 
numbers as you need to. See description of Phone Object to understand different attributes 
that completely specify a telephone number. 

See Also
Person Object 
Phone Object 



Person: Home Fax Numbers

This is a set of fax numbers of the person. You may specify as many fax numbers as you 
need to. See description of Phone Object to understand different attributes that completely 
specify a fax number. 

See Also
Person Object 
Phone Object 



Person: Working With (Share Work Address With)

This attribute is used to denote if the given person is working at the same place as someone
else. A person is said to be working at the same place as another person if he/she is working
for the same company, and has the same work address.
If the person is working at the same place with another person, then you may want to 
specify the name of the person with whom this person is working with. This way the work 
address and (optionally work telephone and fax numbers depending on your Preferences) 
are shared across all the persons working together. When you change the address of one, 
the address change is reflected for all the persons working together. This helps in 
eliminating redundancy in information, and at the same time automatically maintain data 
consistency.
EasyFill feature is active for this attribute. You only need to type in enough number of 
characters to identify the name uniquely. The EasyFill feature will complete the name for 
you. If you type in the name which matches more than one person's name or does not 
match any name at all, a selection box will be displayed for you to make a choice.
Detailed Explanation
Normally, at a given work address, there is one person who is designated as the primary 
person who is working there. Rest of the person work with the primary person. You can 
choose any one person to be the primary person who is working at the given address, and 
the rest of the persons share the company name and work address with this person.
You can change the primary person with whom rest of the people are working with by 
making the primary person work with someone else. 
For example, lets say Jane, Bill and Mike were working with Joe. That means that Joe is the 
primary person working at the given work address, and the Working With attribute is 
empty for Joe. Now, lets say you make Joe work with Jan. Then automatically Bill and Mike 
will also be updated to work with Jane and Jane will become the primary person working at 
the given work address. 
As another example, lets say Jane, Bill and Mike were working with Joe at a given work 
address. Now, if Joe is then edited such that Joe now works with Andy the following action 
will take place. 

· If Andy was already working at a given company and work address, then Joe, 
Jane, Bill and Mike will also have the same company name and work address as 
Andy. 

· If Andy's company name and work address was not yet specified but you have 
already specified the company name and work address of Joe (or Jane or Bill or 
Mike), then Andy will also share the same company name and work address as 
Joe, and will also become the primary person working at that work address. 

See Also
Person Object
Person: Company Name
Person: Working Together

EasyFill



Preferences Dialog



Person: Working Together

This is a read-only attribute which is automatically updated to show who all are working with
the given person, .i.e. sharing the same company name and the work address as the given 
person.

See Also
Person Object 
Person: Company Name
Person: Working With



Person: Company Name

This attribute specifies the company name where the person is working. If the person is 
working (sharing work address) with some other person or other persons are working with 
this person, then changing the company name will change the company name of all the 
persons working together.

See Also
Person Object 
Person: Working With
Person: Working Together



Person: Work Address

This attribute specifies the work address of the person. See description of Postal Address 
to understand different attributes that completely specify a work address.
If the person is working (sharing work address) with some other person or other persons are 
working with this person, then changing the work address will change the work address of all
the persons working together.

See Also
Person Object 
Person: Working With
Person: Working Together
Postal Address 



Person: Work Telephone Numbers

This is a set of telephone numbers of the person. You may specify as many telephone 
numbers as you need to. See description of Phone Object to understand different attributes 
that completely specify a telephone number. 

See Also
Person Object 
Phone Object 



Person: Work Fax Numbers

This is a set of fax numbers of the person. You may specify as many fax numbers as you 
need to. See description of Phone Object to understand different attributes that completely 
specify a fax number. 

See Also
Person Object 
Phone Object 



Person: Working At

This is the place of work of the person. You can specify one work address of a person. The 
work address is another object called the Business Object. You specify an already existing 
business object name as the place of work or you can create a new business object. 
Business objects are separate objects that can exist on their own once created. Also, more 
than one person could be working at the same place, thus you can share the same business 
object. This way you eliminate redundant specification of business address etc. and at the 
same time maintain consistency automatically.
See description of Business Object for details. You specify Business Object by Company 
Name. You only need to type enough characters to identify the business company name 
uniquely. EasyFill feature will complete the name for you.

See Also
Person Object 
Business Object 
EasyFill 



Person: Email Addresses

This is a set of electronic mail addresses of a person. You can specify as many electronic 
mail addresses of a person as you need to. See description of Email Address Object to 
understand different attributes that specify the electronic mail address. 

See Also
Person Object 
Email Address Object 



Person: Father

This is another Person Object who is the father of the person. You specify the father by 
typing the name of the father.
You only need to type as many characters as to uniquely specify the name. EasyFill feature 
will complete the rest of the name for you. 

See Also
Person Object 
EasyFill 



Person: Mother

This is another Person Object who is the mother of the person. You specify the mother by 
typing the name of the mother.
You only need to type as many characters so as to uniquely specify the name. EasyFill 
feature will complete the rest of the name for you. 

See Also
Person Object 
EasyFill 



Person: Spouse

This is another Person Object who is the spouse of the person. You specify the spouse by 
typing the name of the spouse.
You only need to type as many characters so as to uniquely specify the name. EasyFill 
feature will complete the rest of the name for you. 

See Also
Person Object 
EasyFill 



Person: Children

This is a set of Person Objects who are children of the person. Currently this attribute is read-
only and is automatically updated. The determination of the child relationship is made when 
you specify the father or mother attribute of a person. 

See Also
Person Object 



Business Object

Business Object is designed to keep information of businesses, may it be a place of work, 
place where you go out to eat, a travel agency, entertainment company, or anything else 
which is an organization. A business object has the following attributes that you can specify. 

Id
Company Name
Additional Name
Address
Telephone Numbers
Fax Numbers
Email Addresses
Comments



Business: Id

Every object is identified internally by EasyManager with a id. Business objects also are 
assigned an id automatically as soon as the object is created. The id of an object is unique 
within a database. 

See Also
Business Object 



Business: Company Name

Company Name is the primary attribute that is used to identify a business. You can define 
more than one business with the same company name, but it is not advisable to do so as it 
may create confusion while exporting the object to other applications. When creating an 
object, if another object by the same name already exists, EasyManager will give you a 
warning. 

See Also
Business Object 



Business: Additional Name

This attribute can be used to specify a division, a department etc. that identifies a part of 
the company. For example, you may want to keep two different business objects one for the 
Technical Support, another for the Sales Department of one company because they are 
located on different street address.
If the only thing that you want to store for a company is telephone and fax numbers, and/or 
electronic mail addresses then you can just have one business and store many telephone or 
fax numbers or electronic mail addresses each one with a specific comment which 
department it is for. 

See Also
Business Object 



Business: Address

This specifies the postal address of the business. See description of Postal Address to 
understand different attributes that completely specify the street address. 

See Also
Business Object 
Postal Address Object 



Business: Telephone Numbers

This is a set of telephone numbers of the business. You may specify as many numbers as 
you need to. See description of Phone Object to understand different attributes that 
completely specify a telephone number.

See Also
Business Object 
Phone Object 



Business: Fax Numbers

This is a set of fax numbers of a business. You may specify as many fax numbers as you 
need to. See description of Phone Object to understand different attributes that completely 
specify a fax number.

See Also
Business Object 
Phone Object 



Business: Email Addresses

This is a set of electronic mail addresses of a person. You can specify as many electronic 
mail addresses of a person as you need to. See description of Email Address Object to 
understand different attributes that specify the electronic mail address.

See Also
Business Object 
Email Address Object 



Business: Comments

This attribute can be used to store any other information that could not be stored in any of 
the attributes explicitly.

See Also
Business Object 



Group Object

A Group Object is designed to organize individual Person and Business Objects in specific 
purpose groups.
For example, you may want to define a group for friends in California. Any object can be a 
member of the group. An object can be part of any number of groups. A group can contain 
other groups as long as the groups do not form a cycle. This allows you to organize your 
groups hierarchically. For example you could have a group of fax numbers for each state in 
USA, and then have a group of fax numbers for the all of USA.
Following attributes are defined for Group Objects:

Id
Name
Members
Comments



Group: Id

Every object is identified internally by EasyManager with a id. Group objects also are 
assigned an id automatically as soon as the object is created. The id of an object is unique 
within a database.

See Also
Group Object 



Group: Name

This is the primary attribute that is used to identify a group. You can define more than one 
group with the same name but it is not advisable to do so as it may create confusion while 
exporting the object to other applications. When creating an object, if another object by the 
same name already exists, EasyManager will give you a warning. 

See Also
Group Object 



Group: Members

This is a set of objects that constitute the group. The objects can be of any type. Currently, 
objects of type Person, Business or Group can be members of the group. A object can be a 
member of many groups.
A group can be a member of another group as long as the group does not form a cycle. For 
example, If Group A contains Group B, and Group B contains Group C. Then if Group C or 
Group B contains group A a cycle will be formed. 

See Also
Group Object 
Person Object 
Business Object 



Group: Comments

This attribute can be used to store any other information that is associated with the group. 

See Also
Group Object 



Postal Address Object

Postal Address object is used to keep the street address. The street address can be shared 
by many different types of objects that have a postal address. Currently, objects of type 
Person and Business have a postal address. The following components of the address can be
stored.

Street
City
State
Zip
Country

See Also
Person Object 
Business Object 



Postal Address: Street

This is the street name and number. Include the suite or apartment number in this attribute. 
You may want to follow a convention of specifying the suite or apartment number by 
preceding the number by a '#' sign.

See Also
Postal Address Object 



Postal Address: City

This is the city part of the postal address. 

See Also
Postal Address Object 



Postal Address: State

This is the state part of the postal address. Normally, you may want to follow a convention 
on how to enter state names. For example, if you decide you use CA as the sate name for 
California, then use it everywhere you want to specify California.

See Also
Postal Address Object 



Postal Address: Zip

This is the zip code of the postal address. You can use any characters to represent the zip 
code. Some countries have zip codes containing digits only, others have a combination of 
letters and digits.

See Also
Postal Address Object 



Postal Address: Country

This is the country of the postal address.

See Also
Postal Address Object 



Electronic Mail Address Object

Electronic Mail Address or Email address is the electronic address that is used to send and 
receive electronic mail. Depending on what electronic mail service you use, you would have 
a different format of specifying the address.    Electronic Mail Address Object has the 
following attributes:

Address
Type

See Also
Person Object 
Business Object 



Email Address: Address

Attribute is used to keep the electronic mail address in the native form.
For example, if the person has a CompuServe address, specify the address as a CompuServe
address and not as an internet address. This is important so that you can export the 
addresses to different applications more easily. For example, if you export the addresses to 
CompuServe Information Manager, then EasyManager will export the CompuServe address 
as a CompuServe address, if you export the addresses to be used with UNIX mailer, then 
EasyManager will correctly translate the CompuServe address to an equivalent internet 
form.

See Also
Email Address Object 



Email Address: Type

This attribute represents the type or format in which the electronic mail address is specified. 
Currently the following types are valid types. 

· Internet Use this type if you are specifying an internet address
· CompuServe Use this type if you are specifying a CompuServe address
· MCI MailUse this type if you are specifying a MCI Mail address
· America Online Use this type if you are specifying America Online 

address
· Prodigy Use this type if you are specifying Prodigy address

If the address type you have is not supported, then specify it as an internet address. Most 
mailers support sending mail to an internet address.
You only need to enter enough number of characters to uniquely specify the type. EasyFill 
feature will complete rest of the type name for you.

See Also
Email Address Object 



Phone Object

Phone object is used to store a phone number, may it be a telephone number, fax number, 
or automated information numbers. The following details can be stored for a phone:

Number
Comment

See Also
Person Object 
Business Object 



Phone: Number

This is used to specify the number. The number can be entered as digits, or as a 
combination of digits and alphabets. You can use any character as a separator. Commonly 
used separators are dash '-', dot '.' or parenthesis '(' ')'. Normally you may want to reserve a
comma ',' for denoting a pause.
If you are entering the country code, then enclose it within [ and ]. If you are entering area 
code, then enclose it within ( and ). This will help later to distinguish the local area code and 
local country code - useful specially when exporting information to other programs like 
WinFax. Do not enter dialing prefix with the phone number.

See Also
Phone Object 



Phone: Comment

This is used to specify a comment. You can write any comment associated with the number. 
It is specially useful if you have more than one number and you want to note down what 
each number is for.

See Also
Phone Object 



Creating An Object

You create an object either in a EasyList or within the EasyEditor. 

Creating Object Within EasyList
Within EasyList, you can only create an object of the type that the list handles. For example, 
Home Telephone Numbers List shows attributes of Person object. Thus you can only create 
objects of Person type in this list. 
The last row of any editable EasyList is always empty. Entering the name in the name 
column of the last row automatically creates an object of the given type. 

Creating Object Within EasyEditor
To create an object from the EasyEditor, follow these steps: 

1. Make sure that no object is currently selected. EasyEditor always displays the 
selected object if there is a selected object. If there is no currently selected 
object, you can skip this step. Pressing the "New Object" button clears the 
selection if any and grays out all the attributes except the Name attribute. 

2. Press the "Type" button. This will give you a choice of the type of objects that 
you can create. If the type of object you want to create is already being 
displayed in the editor, then you can skip this step. Select the type of object you
want to create. 

3. Enter the name of the object. Entering a name automatically creates an object 
of the given type. Also, all other attributes will also become available for editing.

Note, that this style of creating an object is very different than other software where you 
have to press an "Apply" or a "Create" button to create an object.



Selecting An Object

You may select an Object from any EasyList or from the EasyEditor. An object once selected, 
appears selected wherever it is displayed.

Selecting Object Within EasyList
From the EasyList, clicking on the left most cell of a row will select that object. This cell 
displays the Id of the object.

Selecting Object Within EasyEditor
From the EasyEditor, you can select an object by following the steps below:

1. Choose the type of object you want to select. If the type of object you want to 
select is already displayed in the editor, you can skip this step. Press the "Type" 
button, and it will display a selection box with a list of all the possible types of 
objects. Double click on the type you want, or click once, and then press the OK 
button. 

2. Press the "Sel... " button at the bottom of the editor. This will display a selection 
box with the name of all the objects of the given type. Click on the object you 
want to select, and then press OK. Double clicking on the object you want to 
select is equivalent to clicking once and then pressing OK button.
Or

3. Press the First (<<), Last (>>), Next (>) or Previous (<)    buttons. This will 
select the first, last, next or previous object as appropriate.
Or

4. Enter the name that you want to select in the Find box and press return. You 
may enter only partial name. If the name matches an object uniquely, that 
object will be selected. If the name matches more than one object or if it does 
not match any object, a selection box will be displayed to select from.



Editing An Object

You can edit an object anywhere it is displayed. All the attributes of an object can be edited 
in the EasyEditor. You can also edit any attribute of the object from any EasyList that 
displays that attribute.

Editing Object In EasyList
To edit an attribute from within an EasyList, simply double click in the cell which you want to 
edit and type the new attribute value and press return. For many attributes, you may use 
the EasyFill feature to enter the value partially and let EasyFill feature complete the value for
you. Refer to individual attributes help to see if EasyFill feature can be used for the given 
attribute.

Editing Object In EasyEditor
To edit an object within the EasyEditor, you need to first invoke the editor. You can invoke 
the EasyEditor in any of the following ways: 

1. From an EasyList by double clicking on the left most cell ( that displays the Id) of
the object you want to edit. This selects the object, and invokes the EasyEditor 
with the selected object ready for editing. 

2. From the Edit menu, by selecting the Editor menu item. 
3. By pressing the keyboard shortcut Ctrl-E. Press the "Ctrl" key and the "E" key 

simultaneously.
Next, you would need to select the object that you want to edit, if the object is already 
selected, you can skip this step. If not, then follow the steps on Selecting An Object to select 
an object.
Now, edit the desired attribute. See EasyEditor details on different ways to edit attributes.



Jump To Object

You can jump to an object from EasyEditor and EasyLists. You can jump to object in one of 
the following ways:

1. Go the attribute that is displaying the object name that you want to jump to.
2. Press the keyboard shortcut Ctrl+J  Press Ctrl Key and J key simlutaneously. or
3. Select Jump To Object from the Edit menu.

EasyEditor
Within EasyEditor, you can jump to an object that is being referred to by an attribute of the 
currently displayed object. By jumping to the object also selects the object.
Example

If the EasyEditor is displaying a Person Joe. The name of his father is Bill. To display Bill, you 
can simply go to the father attribute, and then Jump To Bill by pressing Ctrl+J.
EasyList
Within EasyList, jump to implies scroll to object. You can scroll to an object that is being 
referred to by its name in one of the columns except for the first column.
Example

Lets say one of the columns of EasyList displays Living With attribute of Person objects. Each
row displays attributes of one object that is identified by its id in the Id column and by its 
name in column one. Lets say Joe is displayed in one of the rows and Joe is living with Sue. 
To scroll to Sue, go to the Living With attribute of Joe, and press Ctrl+J. The list will scroll to 
the row where Sue object is displayed in the list.



Deleting An Object

To delete an object the object must first be selected. See Selecting An Object to select an 
object. You can delete a selected object by any of the following ways :

1. Select the Delete Object menu item from the Edit menu. 
2. Press the keyboard shortcut Ctrl+D. Press Ctrl Key and the "D" key 

simultaneously. 



Viewing An Object

You may view objects in many ways. You may:
· View (and Edit) In EasyList
· View (and Edit) In EasyEditor
· View In EasyLook

Viewing In EasyList:
There are times when you want to view only some of the attributes of a given type of 
objects. For example, you may want to view only the telephone numbers of all Business 
objects. The best place to view only specific attributes of all or some objects of one type is 
EasyList. 
EasyLists help you to view only the information that you want to. EasyManager comes with 
some predefined EasyLists. You may create new EasyLists, modify existing EasyLists or 
delete them altogether. See Customizing EasyList on how to create new or modify or delete 
existing EasyLists. 

Viewing In EasyEditor:
EasyEditor is the best place to view all the attributes of one object. You may view any object 
of any type in EasyEditor, but only one object at a time. EasyEditor is also one of the 
windows to edit any attribute of the object you are viewing. 

Viewing In EasyLook:
If you want to look at some standard information quickly without having to search through 
the EasyLists or going through the EasyEditor, then EasyLook is the place. You cannot edit 
any of the attributes that you see, but it is very convenient place to lookup information like 
home address, telephone number, fax number and the like.
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Getting Started

The first important information is to remember that you can get help by simply pressing F1 
Key from anywhere in the program. You can also obtain context-sensitive help by pressing 
Shift+F1 Key at anytime.
After you have successfully installed EasyManager, read the following topics first.

Features for the features of EasyManager.
Overview for an overview of EasyManager.
Objects for an introduction to the concept of objects.

After that, the first thing you would do is open a new document. Select New... menu item 
from the File menu to create a new document. You may also open an existing document if 
you have any, by selecting the Open... menu item from the File menu.
Open the EasyEditor by selecting the EasyEditor... menu item from the Edit menu or by 
pressing the Ctrl+E key, or by clicking on the  in the toolbar.
Now you are ready to create/edit/delete objects. See help on the following topics:

Create An Object for steps on how to create objects
Edit An Object for steps on how to edit objects.
Delete An Object for steps on how to delete objects.
Select An Object for steps on how to select an object.
View An Object for steps on how to view objects.

After creating a few objects, open a predefined EasyList. Select any EasyList that interests 
you by selecting the appropriate menu item from the EasyLists menu. You can view, create,
edit, and delete objects from any EasyList also. See the topics above for help.
You can save the file with all the changes by selecting the Save... menu item from the File 
menu. You will be prompted for a file name if you opened a new file.
By now, you can open a file, create, edit and delete objects, view objects and save the file.

The next step, is to learn to create or modify the pre-existing EasyList(s) to meet your needs.
Select the Define EasyLists... menu item from EasyLists menu. See help on following 
topics for details:

Create A New EasyList for steps on how to create a new EasyList.
Edit An Existing EasyList Definition for steps on how to edit an existing EasyList.
Delete An Existing EasyList for steps on how to delete an existing EasyList.

For other advanced topics, ask for help under the appropriate index in the Table Of Contents.



Getting Help

When running EasyManager, help is always at hand whenever you need it. You can ask for 
help in any of the following ways:
At any time in the program, Press F1 Key. This brings up the help window with the help for 
the last active window. It could be a message box, EasyEditor, EasyList, or anything else.
You can get context sensitive help for menu commands and toolbars by pressing Shift-F1, 
and then clicking on the menu item, or the toolbar button.
You can go to the top level help by selecting the Help Index menu item from the Help menu.



Overview Of EasyExport

One of the advantage of using EasyManager is to help you manage information at one 
common place, and then allow you to easily export the Object to other applications.
When you export the desired objects to other programs the following points are worth 
knowing:

· Only the data relevant to that application is exported.
· All data that is exported is uniquely identified by the name of the object.
· EasyExport never deletes the old information that was not exported before by 

EasyManager.
· While exporting, if a record/object already exists in the application database but

does not exist in the EasyManager database (identified by name), than that 
record is untouched during the export. 
The only time the record will be deleted from the application database is if (1) 
the record was previously exported by EasyManager, (2) the object has not 
been chosen to be exported or has since been deleted from EasyManager 
database, and (3) you have explicitly asked to delete previously exported data 
by checking the check box in the export dialog box.

· If a record/object exists both in the application database and in the 
EasyManager database (identified by name), than that record is updated with 
the relevant data that exists in EasyManager database.

· If a record/object does not exists in the application database, but exists in the 
EasyManager database (identified by name), than a new record is created in the
application database and the relevant data exported from EasyManager 
database.

Currently, you can export relevant data of the desired objects to following applications.
· CompuServe Information Manager Address Book (Versions 1.x and 2.x)
· EasyList Data To Comma/Tab Separated Text File that can then be exported to 

other Spreadsheet, Database and many other applications that read comma/tab
separated data.

· WinFAX Fax Application
This is an area where support for more applications are being developed. Make sure you 
have registered EasyManager so that you get new updates with support for exporting data 
to more applications. See Registering EasyManager on how to register.
If you have a favorite application that you would like to export data to, let us know. See 
Feedback on how to contact us.
For step by step instructions on exporting objects of your choice, see Exporting Objects.



EasyExport - Exporting Objects

To export relevant attributes of objects to other programs you invoke the EasyExport in one 
of the following ways:

1. Select the EasyExport menu item from the File menu.
2. Press Keyboard shortcut Ctrl + X - Press X key while holding down the Ctrl key.

This will invoke the EasyExport Dialog. Follow the steps below to export the objects:
1. Select the objects you want to export. You can choose to export all objects of 

one or more types in the database, or all objects that you can view in any of the
open EasyLists, or any combination of these.

2. Select the target application/destination where you want the relevant attributes 
of the objects to be exported by selecting one of the items in the Target list 
box. The contents of the list box displays only the relevant targets to which you 
can export depending on the objects that you have chosen to export.

3. Select the data that you want to export from the Data To Export list box. The 
contents of the list box displays only the data that you can export, relevant to 
the target that you have chosen.

4. Modify the export file name if necessary to specify the file where the data 
should be exported into.

5. Check the Delete Previously Exported Data check button if you want to 
delete the data that you had exported before (if any). This should generally be 
checked if you are exporting all the objects in the database.

6. Click OK.

Also See
EasyExport
EasyExport Dialog



EasyExport Dialog

This dialog allows you export the desired data of desired objects to the desired target.

Objects To Export
All Person Objects: Check this box to export the relevant data of all the Person objects in 
the database.
All Business Objects: Check this box to export the relevant data of all the Business 
objects in the database.
All Group Objects: Check this box to export the relevant data of all the Group objects in 
the database.
Objects In List: Check this box and select a EasyList to export the objects that you view in 
the chosen EasyList.

Export Target
DosCIM 1.x or DosCIM 2.1.x: Select this target to export the relevant data to CompuServe
Information Manager Address Book for DosCIM versions 1.x or 2.1.x.
DosCIM 2.2.x or WinCIM 2.x: Select this target to export the relevant data to CompuServe
Information Manager Address Book for DosCIM version 2.2.x or WinCIM 2.x.
Tab Separated Text File: Select this target to export all the data in the selected EasyList 
as a tab separated text (ASCII) file. This data can then be read by many spreadsheets, 
databases and word processor programs. This option is available only if you select the 
Objects In List option in the Objects To Export section.
Comma Separated Text File: Select this target to export all the data in the selected 
EasyList as a comma separated text (ASCII) file. This data can then be read by many 
spreadsheets, databases and word processor programs. This option is available only if you 
select the Objects In List option in the Objects To Export section.

Data To Export
Email Address: Select this choice to export the electronic mail addresses of the desired 
objects to the desired target. This choice is available only if it is relevant for the selected 
target.
Fax Numbers: Select this choice to export fax numbers of the desired objects to the desired
target. This choice is available only if it is relevant for the selected target.
Telephone Numbers: Select this choice to export telephone numbers of the desired objects
to the desired target. The choice is available only if is relevant for the selected target.
Postal Address: Select this choice to export postal address of the desired objects to the 
desired target. The choice is available only if is relevant for the selected target.
Email Address And Fax Number: Select this choice to export electronic mail address and 
fax numbers of the desired objects to the desired target. The choice is available only if it is 
relevant for the selected target.



List Data: Select this choice to export the EasyList data to the desired target. The choice is 
available only if its relevant for the selected target.

Delete Previously Exported Data
Select this option to delete any information that was previously exported from EasyManager.
EasyManager puts a tag wherever possible for all information that it exports. This way if an 
object or the data is deleted, that data is also deleted from the target when exporting the 
current information.

Export To File
Specify the file name with full path or relative path from the current working directory. When 
you choose a target, the default file name is filled.

Browse Button
Click on this button to browse the file directory on the disk to choose a file name where to 
export.

Export Button
Click this button to export the relevant information from the selected objects.

Cancel Button
Click on this button if you want to cancel the export process.

See Also
Exporting Objects



EasyImport - Importing Data

EasyImport imports data from text files and from other applications. Currently, it supports 
importing from the following sources:

· Character Separated Text files
· CompuServe Information Manager Address Book

In future, more sources will be supported for import. If you have a favorite program, and 
would like to import information directly from that application, please let us know. Go to 
feedback on how to contact us.
Follow the steps below to import data:

1. Select the EasyImport menu item from the File menu, or Press keyboard 
shortcut Ctrl + I. This will invoke the EasyImport Dialog.

2. Select one of the sources from the list of possible import sources either by 
clicking on the desired source, and pressing Import button, or by double 
clicking on the desired source.

3. This will display the appropriate dialog box. You can change the default values in
the dialog box to customize the import behavior. Press Import button to import 
relevant data from the chosen source.

Also See
Importing From Text File
Import Text File Dialog
Import CompuServe Address Book Dialog



Importing From Text File

EasyImport can import any data that you desire from character (comma, tab, semicolon, 
etc.) separated text files. Each record represents an Object within EasyManager. Records in 
the text file should be separated by new line, while fields or attributes should be separated 
by a single character specified in the dialog box. The first field in the record should be the 
name attribute of the object. If a field value is empty for any record, the particular field 
value is not modified while importing.
Follow the steps below to import data:

1. Create or modify an existing EasyList such that each of the columns in the 
EasyList represents a field in the text file. If you want to ignore a field, define 
the corresponding column as empty column.

2. Select the EasyImport menu item from the File menu, or Press keyboard 
shortcut Ctrl + I. This will invoke the EasyImport Dialog.

3. Select Character Separated Text File as the import source by either doubling
clicking on the import source, or by clicking on the import source once, and 
pressing Import button. This will display the dialog box for importing from 
Character separated text file. Enter/change the default values, and press 
Import. This will import the data from the specified text file.

Also See
Import Text File Dialog
EasyImport - Importing Data



Import Text File Dialog

The following options allow you to specify what data to import:

Import From File
Enter the name of the file (data source) from which the data is to be imported. You may 
use the Browse button to browse the files.

EasyList That Represents Column Format
Select an EasyList whose column definition matches the column definition of the text file 
from which data is to be imported.

Has Row Headers
Check this box if the first field of each record represents the record header. For example, 
the first record could represent a record Id. Checking this box simply ignores the first 
column of every record.

Has Column Headers
Check this box if the first record in the text file represents the column (field) headers. 
Checking this box simply ignores the first record.

Column Delimiter
Select or enter a column delimiter. A column delimiter is a one character separator that 
is used to separate column (field) entries.

Append To Existing Data
This option affect only attributes that can have multiple values. Check this box if the 
previous attribute values of a multiple-valued attribute should not be deleted before 
importing data. For example, a Person object can have multiple home telephone 
numbers. If you were importing home telephone numbers, the numbers being imported 
can be added to the list of existing telephone numbers for a given Person, or the existing
numbers can first be deleted before importing a telephone number for a given Person. 
Checking this box will not delete the existing numbers before importing.

Also See
Importing From Text File
EasyImport - Importing Data



Import CompuServe (CIM) Address Book Dialog

The following options allow you to specify what data to import:

Import From Address Book [File]
Enter the name of the file (data source) from which the data is to be imported. You may 
use the Browse button to browse the files.
Normally, it is C:\CSERVE\support\addrbook.dat for WinCIM and for DosCIM versions 
2.2.x. For DosCIM versions 1.x and 2.1.x, the path is C:\CSERVE\addrbook.dat. If CIM is 
installed in a directory other than C:\CSERVE, then replace C:\CSERVE with the directory 
where CIM is installed.

Type of object to create If Name does not exist
Select the type of object to create for names that do not exist in the database. This 
information is used only for non-group records. Group objects are created for group 
records.
When importing from the address book, EasyManager attempts to find an existing Object
by the name of the record that is being imported from the address book. If it cannot find 
a Person or a Business object by name, it will create a new object. You can decide what 
type of object to create in such cases.

Do not import previously exported records
Check this box if you do not want re-import records that were previously exported from 
EasyManager. A record exported by EasyManager is identified by the {{EasyManager 
Exported Data}} string as the comments for that record.

Append To Existing Addresses
Check this box if you want to append the addresses being imported to the existing 
electronic mail addresses/fax numbers for the objects being imported. Uncheck this box 
if you want to delete the existing addresses before importing addresses for the objects 
being imported.
While importing addresses, even if this box is checked, it will not create duplicate 
address if the address already exists for the object being imported.

Also See
EasyImport - Importing Data



EasyLabel Window Layout

EasyLabel window displays the labels by evaluating the label format specification. Labels are
displayed the way they will be printed. If the label format is defined as simple or advanced 
format, one label is displayed for each object of the specified type.
EasyLabels can also be used to print Address Books, and other books that represent the data
of your choice. Define the label format specification appropriately using the Define 
EasyLabel... menu item from EasyLabel menu.
EasyLabels can also be used to print from address labels. Use the fixed label format and 
enter your address as the label specification.
You can modify the contents of the label (after label format specification has been 
evaluated) before printing or exporting by editing the label data directly.
You can also change the label width, height, and horizontal and vertical spacing between 
labels by draging the edge of the label in the row or column headers. Changing the size in 
this way does not save the page setup for the label for later use.

Buttons

Export...
Press this button to export the label data to a text file. Note that labels are always 
exported as one column even if the labels are displayed in more than one column.

Print...
Press this button to print the labels on plain paper or on label forms.

Page Setup...
Press this button to change the page setup for the labels. This invokes the EasyLabel 
Page Setup Dialog.

Close
Press this button to close the label window.

See Also
EasyLabel Page Setup Dialog
EasyLabel Editor
Define EasyLabel...



EasyLabel Editor

EasyLabel Editor presents the following options to define labels:

EasyLabel Name
Specify the name of the EasyLabel. This is the name that will appear under the 
EasyLabel menu. The name should not be the same as another EasyLabel name.

EasyLabel Format
Select a format for the contents of the EasyLabel.
Fixed Format: Select fixed format to create an label with no variables. This format is 
useful for printing your own from address labels. You must also specify the Number of 
Labels that you want to print.
Simple Format: Select this format if you want to define a label with embedded object 
attributes. You must also select the Type of object for which you want to define the label.
Advanced Format: Select this format if you want to define a label with embedded 
object attributes. This format requires the understanding of the internal data model, and 
hence is not advised for users. You must also select the Type of object for which you 
want to define the label.

Type
Specify the type of objects for which this label is being defined. You must select a type if 
you are defining a simple or advanced format labels.

EasyLabel Format Specification
Specify the label definition. The label can contain normal text, and attribute variables. To 
insert a attribute variable, position the cursor where you want to insert the variable, and 
then double click the desired variable from the Attribute Choices List. The variable will
appear within enclosed angle parenthesis.

Number of Labels (fixed format)
Specify the number of labels to print for fixed format labels. For simple and advanced 
format labels, the number of labels is determined by the number of objects of the chosen
type.

Attribute Choice List
This presents a list of all possible attributes for a given Type of objects. You can insert an
attribute in the label format specification by simply double clicking any of the attribute 
choice.

Page Setup...
Click this button to display EasyLabel Page Setup Dialog. Use the page setup dialog to 
specify the page layout for printing labels 

See Also
EasyLabel Page Setup Dialog



EasyLabel - Page Setup Dialog

The following options allow you to specify the page setup for printing labels:

Label Style
Select a predefined label style if one exists, or select custom style.

Paper Size
Specify the width and height of the paper in inches.

Margins
Specify the left, right, top and bottom margins in inches.

Column Parameters - Width
Check the Max Fit box if you want the program to determine the maximum label width 
that will fit all the text or else specify a fixed label width in inches

Column Parameters - Number of columns
Specify number of columns i.e. number of labels to be printed across on a page.

Column Parameters - Space between columns
Specify the space between columns in inches if the number of columns is more than one.

Row Parameters - Height
Check the Max Fit box if you want the program to determine the maximum label height 
that will fit all the text or else specify a fixed label height in inches

Row Parameters - Space between rows
Specify the space between label rows in inches.

See Also
EasyLabel Editor



Editing Date Attribute

Any attribute that represents a date, can be edited as follows:
1. Double click in the cell you want to edit.
2. Press F2 to clear the date value.
3. Press F3 to enter today's date.
4. Press F4 to pop-up a calendar to choose a date.
5. Use the spin buttons to increment or decrement the date values.
6. Type in the date in MM/DD/YYYY format. The separator '/' appears      

automatically as you type each component of date.
MM represents the month, valid values are 01 to 12
DD represents the day, valid values are 01 to 31
YYYY represents the year, valid values are 1900 to 2100



Overview Of EasyFill

EasyFill feature boosts your productivity by completing partially filled values for many of the 
attributes of Objects. When editing an attribute that supports EasyFill feature, simply type in 
a few characters and press return. EasyFill feature will takes the following action:

· If you typed in enough number of characters to uniquely identify the value to 
complete, it will do so.

· If the number of characters you typed in, matches more than one possible 
values that could be used for completion, a selection box will be displayed with 
the set of possible value choices that match the characters that you typed in.

· If the number of characters you typed in does not match any of the possible 
values that could be used for completion, a selection box will be displayed with 
all the possible value choices 

· You then make a selection of the value you want by double clicking on one of 
the items in the selection box, or by clicking once to select the item and 
pressing OK.

To find out if a given attribute supports the EasyFill feature, see the help on the individual 
attribute.
In general, all attributes that refer to other objects like Person, Business and Groups support 
the EasyFill feature. Also, if there was only a predefined and discrete set of choices that can 
be entered for a particular attribute, than that attribute also supports the EasyFill feature. An
example of such an attribute is Sex in Person Object.



Overview Of EasyList

EasyList is a powerful way to view and edit the desired attributes of a specific type of object.
An EasyList specifies a set of attributes in a particular order that is convenient to you. For 
example, you may want to define a EasyList to view and/or edit person home telephone 
numbers only and not have to worry about other attributes or Person Object.
EasyLists provide a consistent view of the Objects across all EasyLists and all other ways 
that you view the Objects. See Viewing An Object on different ways to view any Object.
You use EasyLists for the following activities:

1. Create an object. See Creating An Object on how to create objects in a 
EasyList.

2. Delete an object. See Deleting An Object on how to delete objects using 
EasyLists.

3. Modify attributes of the objects that you view. See Editing An Object on how to 
modify objects in a EasyList.

4. Select an object. See Selecting An Object on how to select an object that you 
see in a EasyList.

5. Define filter criteria on what objects you want to view. See Filtering Objects on 
how to define filters so that you only view objects that meet the filter criteria.

6. Export only the objects that you view (filtered by the filter criteria). See 
Exporting Objects on how to export objects in a EasyList.

EasyManager comes with a set of predefined EasyLists that you can access from the 
EasyList menu as mentioned below.

Person Home Address List
Display and edit home address of Person objects 

Person Work Address List
Display and edit work address of Person objects

Person Telephone List
Display and edit home and work phone number of Person objects

Person Email List
Display and edit electronic mail addresses of Person objects

Person Birthday/Anniversary List
Display and edit birthday and anniversary dates of Person objects

Family Relations
Display and edit parent and spouse relationship between Person objects

Business Address List
Display and edit postal address of Business objects

You can create your own EasyLists and add them to or remove them from the EasyList 
menu using the Define EasyList command. 



See Also
EasyList Layout
Customizing EasyList 
Overview of EasyEditor 
Overview of EasyLook 

Overview of Objects 
Creating An Object 
Editing An Object 
Deleting An Object 
Viewing An Object 
Selecting An Object 



EasyList Layout

The EasyList window displays the desired attributes of the objects of a given type as lists.
The name of the EasyList is displayed as the title of the window. The title will also display a 
number if more than one EasyList window with the same title is open. A new EasyList with 
the same title can be opened by clicking on the New menu command from the Window 
menu.
The list of objects and their desired attributes are displayed as follows:

· Each row starts with a row header. Row headers display the Id of the object 
being displayed in that row.

· Each column starts with the column header. Each column header displays the 
column title. The title can be customized by you. Each column displays the 
value of the attribute of the object that is identified by the object Id in the row 
header.

· The first column always displays the name of the object.
· The rest of the columns display the desired attributes of the object. Each 

column displays only one attribute of the object.

You can perform the following actions on the list:

Scroll
Use the scroll keys to scroll the list.

Edit Attribute
To edit an attribute, double click in the cell you want to edit. You will enter the edit mode.
Modify the value and press return or press one of the arrow or tab keys to end edit mode.
The attribute value is automatically updated in all other EasyLists and EasyEditor where 
the attribute is displayed.

To cancel the edit mode, press Esc.
Select Object

You can select an object by clicking on the object Id cell which is displayed in the row 
header. The selected object appears in reverse video.

Deselect Object
Click anywhere in the list except the row header, and the selected object (if any) will be 
deselected.

Delete Object
Select the object that you want to delete, and press Ctrl+D, or select the Delete Object 
command from the Edit menu.

Create New Object
Go to the first column of the last row. Enter the name of the object you want to create. 
The object is automatically created, and is displayed in all the open EasyLists.

Invoke EasyEditor
Double click on the object Id of the object you want to edit. EasyEditor will be displayed.

Buttons

Editor...



Press this button to invoke the EasyEditor.
Sort

Press this button to resort the EasyList based on the first column, which displays the 
name of the object. Normally, when creating and modifying the name of the object, the 
objects are not automatically sorted. To sort the objects, press this button.

Find...
 Press this button to find an object by name within the EasyList.

Filter...
Press this button to define a filter criteria to use while displaying the objects. Only the 
objects that satisfy the filter criteria will be displayed.

Close
Press this button to close the EasyList.

See Also
Overview of EasyList
Customizing EasyList
Overview of EasyEditor
Overview of EasyFilter
Overview of EasyLook



Customizing EasyList

You can do the following basic operations in order to define and customize EasyLists.
1. Create a new EasyList
2. Modify the definition of an existing EasyList
3. Delete an existing EasyList
4. Choose a font in which to display all EasyLists

Creating a New EasyList
1. Select the Define EasyList menu item from the EasyLists menu. Define 

EasyList dialog will be displayed.
2. Click on the New button to define a new EasyList. The EasyList Editor will be 

displayed.
3. Define the title, the object type, and the columns.
4. Press OK.

Modifying Definition of An Existing EasyList
1. Select the Define EasyList menu item from the EasyLists menu. Define 

EasyList dialog will be displayed.
2. Select the EasyList which you want to modify and press the Edit button. or 

double-click on the EasyList. The EasyList Editor will be displayed with the 
existing definition of the selected EasyList.

3. Modify the EasyList as desired.
4. Press OK. The EasyList definition will be updated and the EasyList Editor 

dialog will be closed.
5. Press Close.

Deleting An Existing EasyList
1. Select the Define EasyList menu item from the EasyLists menu. Define 

EasyList dialog will be displayed.
2. Select the EasyList which you want to delete and press the Delete button. The 

EasyList will be deleted.
3. Press Close.

Selecting EasyList Font
1. Select the EasyList Font menu item from the EasyLists menu. EasyList Font 

dialog will be displayed.



2. Choose the desired font, and press OK.
3. All the EasyLists will be updated to use the chosen font.

See Also
Overview of EasyList
EasyList Editor
EasyList Layout
Printing EasyList



EasyList Editor

EasyList editor is used to define a new EasyList or to modify the definition of an existing 
EasyList. An EasyList is fully defined when the following components are defined:
EasyList Name: A unique name of an EasyList. A name must be specified to identify the 
EasyList, and it must be unique within all the defined EasyList to avoid confusion.
Type: The type of object that is to be displayed in the EasyList. Only one type of object can 
be displayed in a given EasyList.
Columns: You must define all the columns of an EasyList. A column is defined by specifying 
the attribute to display in the given column, the column title, and the column width. The
list of attributes that can be displayed depends on the type of object.
Column Attribute: Select the attribute to display by selecting one of the item in the combo-
box for the column.
Column Title: Specify the title of the column that should appear at the top of the column. By 
default it is the same as the name of the attribute.
Column Width: Specify the width of the column by dragging the anchor at the top right of 
the desired column. You may also change the width of the column later from the EasyList 
directly.
Insert Column After: To insert a new column after a given column, select the column after 
which you want to insert a new column. Press the Insert Column After button. A new 
column will be inserted just after the current column.
Insert Column Before: To insert a new column before a given column, select the column 
before which a new column is to be inserted. Press the Insert Column Before button. A 
new column will be inserted before the current column.
Delete Column: To delete a given column, simply select the column by clicking anywhere in
the column, and then press the Delete Column button. The column will be deleted.

See Also
Overview of EasyList
Customizing EasyList



Printing EasyList

EasyLists can be printed on any Windows compatible printer. The EasyList is printed exactly 
the way you see on the screen. If you want to hide a particular column, simply resize the 
column to zero width. You may customize the printing by selecting or deselecting the print 
options in the EasyList Print Dialog.

To print an EasyList, follow the steps below:
1. Open the EasyList that you want to print by selecting the desired EasyList menu

item from the EasyLists menu.
2. Select the Print EasyList menu item from the File menu or the Print EasyList

button on the toolbar or press the Ctrl+P keyboard shortcut. The Print EasyList 
dialog will be displayed.

3. Customize by choosing the desired print options.
4. Press OK.

See Also
EasyList Print Dialog
Overview of EasyList
EasyList Editor



EasyList Print Dialog

The Print dialog is used to customize EasyList printing. Following options can be customized:
Header The text to print at the top of each page. Click on Header to view 

details on customizing it.
Footer The text to print at the bottom of each page. Click on Footer to view 

details on customizing it.
Margins Specify the size of top, bottom, left, and right margins in inches.
Grid Select to print grid.
Border Select to print border around the EasyList.
Color Select to print colors, deselect to print in gray scale.
Column Headers Select to print column headers, deselect to not print column 

headers
Row Headers Select to print row headers (object ids), deselect to not print row 

headers.
Header Shadows Select to print a shadow effect on column and row headers. This

option has no effect if both Column Headers and Row Headers are 
deselected.

All Pages Select to print all the pages of the EasyList. The From and To are 
ignored if this option is selected.

From Enter the first page to print if All Pages is not selected.
To Enter the last page to print if All Pages is not selected.
Smart Print Select to fit the EasyList on the page as best as possible. Click on 

Smart Print to view rules that are used to print if this option is selected.

See Also
Printing EasyList



EasyList Print Dialog: Header/Footer

Specifies the text to be printed as the header at the top of each page, and as the footer at 
the bottom of each page.

The default header prints the Title of EasyList and the default footer prints the page number.
You can however, customize the textual contents as well as the format of header/footer the 
way you want to. Following control characters are available to format the header/footer.

Escape code Description

/n New line
/l Left justify text
/r Right justify text
/c Center text
/p Insert page number
// Print '/'
/fn Font name followed must be enclosed in quotes "".
/fz Font size must be enclosed in quotes "".
/fb0 Font bold off.
/fb1 Font bold on.
/fi0 Font italics off.
/fi1 Font italics on.
/fu0 Font underline off.
/fu1 Font underline on.
/fk0 Font Strike through off.
/fk1 Font Strike through on.
/fs1 Save the current font configuration as configuration 1.
/fs2 Save the current font configuration as configuration 2.
/fs3 Save the current font configuration as configuration 3.
/fs4 Save the current font configuration as configuration 4.
/fs5 Save the current font configuration as configuration 5.
/fs6 Save the current font configuration as configuration 6.
/fs7 Save the current font configuration as configuration 7.
/fs8 Save the current font configuration as configuration 8.
/fs9 Save the current font configuration as configuration 9.
/f0 Reset the font to the spreadsheet.
/f1 Recall font configuration 1.
/f2 Recall font configuration 2.
/f3 Recall font configuration 3.
/f4 Recall font configuration 4.
/f5 Recall font configuration 5.
/f6 Recall font configuration 6.
/f7 Recall font configuration 7.
/f8 Recall font configuration 8.
/f9 Recall font configuration 9.

Header Examples:



 
/fb1 /l Title Of EasyList\n Prints in EasyList font name and font 

size, bold and left justified.
/fb1 /fi1 /c Title Of EasyList\n Prints in EasyList font name and font 

size, bold, italic, and center justified
/fn"Arial" /fz"14" /fb1 /c Title Of 
EasyList\n

Prints in Arial font, in font size 14, bold 
and center justified.

Footer Example:
/fb1 /l Page /p Prints in EasyList font name and font 

size, bold and left justified, inserts 
current page number while printing.

Note 1: The default font is the same as the EasyList font.
Note 2: You can override the default font by explicitly specifying the name, size, and 

other font attributes explicitly.
Note 3: You can use any font name that you can choose for EasyList. To see all the 

available fonts on your system, select the EasyList Font menu item from the 
EasyLists menu.

Note 4: You can use any font size that you can choose for EasyList for a given font. To 
see all the available font sizes for the given font name n your system, select the 
EasyList Font menu item from the EasyLists menu.



EasyList Print Dialog: Smart Print

Selecting Smart Print option prints the EasyList to best possible fit on a page. The following 
rules are used to determine the best fit:

1. If the number of columns are wider than a portrait page, the EasyList will print in 
landscape mode.

2. If the information still will not fit, but will fit in landscape mode if the EasyList is 
reduced up to 60% its original size, the EasyList will be scaled to fit within the 
page.

3. If the information is still too wide, the last attempt is to reduce the column widths 
to accommodate the widest string within each column.

4. If all attempts at trying to make the EasyList print within one page have failed, 
printing will resume normally in the current printer orientation with no reductions.



Overview Of EasyEditor

EasyEditor is the window where you can view and edit all the attributes of one object at a 
time. EasyEditor complements the EasyList in the sense that EasyList is the place where you
see the desired attributes of all (filtered using the filter criteria) the objects of a given type 
at one time, whereas in EasyEditor you see all the attributes of one object at one time. Both 
have their usefulness. You can choose to view and edit in any of the EasyLists or the 
EasyEditor. depending on your need and convenience.
You use EasyEditor for the following activities:

1. Create an object. See Creating An Object on how to create objects of any type 
in EasyEditor.

2. Delete an object. See Deleting An Object on how to delete objects of any type 
using EasyEditor.

3. Modify attributes of the object. See Editing An Object on how to modify object 
in EasyEditor.

4. Select an object to edit. See Selecting An Object on how to select an object to 
view in the EasyEditor.

To view and edit an object in the EasyEditor, you first select the object you want to view 
and/or edit. Once you select the object, it will be displayed in the editor. You can then view 
and modify the individual attributes as you desire.
As soon as you modify a value of the attribute, the modified value is immediately visible 
everywhere the attribute is displayed including all the open EasyLists.
The EasyEditor changes its form depending on the type of object. The different types of 
objects that you can directly create, delete and modify are Person, Business and Group.
The editor window layout is explained in EasyEditor Layout.

See Also
EasyEditor Layout 
Overview of EasyList 
Overview of EasyLook 

Overview of Objects 
Creating An Object 
Editing An Object 
Deleting An Object 
Viewing An Object 
Selecting An Object 



EasyEditor Layout

The EasyEditor window is divided into three distinct areas. 
1. Title Area. This is the title of the window itself.
2. Object Display Area: This is the area that displays all the attributes of the 

chosen type of object.
3. Button Area: This is the bottom area of the editor where all the buttons are 

located.

Title Area
The title of the editor displays information of the current status of the editor
The title is continuously updated to reflect the current status of the editor. The title has the 
following format:

EasyEditor: <Edit Status> <Object Type>
The edit status    is either "Editing" or empty.
The Object Type is the type of the object that is displayed in the Object Display Area. For 
example, Person is an object type. Business is another object type.

Object Display Area
This is the area where you view and edit all the attributes of a given type of object. This area
changes its form depending on the currently chosen type of object. If an object is currently 
selected , then the type of object is the type of the selected object, otherwise the type of the
object is the type of object that you choose by pressing the Type... button (see below).
Each attribute of the object is displayed in one line as follows:

Attribute Name    Attribute Value Box    [<Attribute Buttons>]
Attribute Name is the name of the attribute that is displayed in that row
Attribute Value Box is the value of the attribute if an object is being displayed, or empty if
no attribute is being displayed. The value box is white if you can edit the value of the 
attribute. It is gray if you can only read the value, but not edit it. 
For attributes, that can have multiple values, the value box is a drop down list box capable 
of displaying multiple values of the attribute. If the attribute is a date, then the value box 
displays date spin buttons. Otherwise, the value box is a simple edit box where you can type
the value or modify the old value.
Attribute Buttons are buttons that further help in editing the attribute values. Different 
buttons appear and disappear depending on the attribute 
The following attribute buttons may appear at various times:
New Attribute Button: This button appears only for attributes that specify postal address, 
electronic mail address or phone numbers. Pressing this button will pop up a window to 
define a new value of the attribute.
Delete Attribute Button: This button appears only for attributes that specify postal address, 



electronic mail address or phone numbers. Pressing this button will delete the existing value 
of the attribute. If the attribute can have multiple values, than a selection box will be 
displayed first for you to choose which particular value you want to delete.
Edit Attribute Button: This button appears only for attributes that specify postal address, 
electronic mail address or phone numbers. Pressing this button will pop-up a window to edit 
the existing value of the attribute. If the attribute can have multiple values, than a selection 
box will be displayed first for you to choose which particular value you want to edit.
Add Attribute Button: This button appears only for multi-valued attributes. Pressing this 
button will pop-up a selection box for you to select one of the possible values to add to the 
attribute.
Remove Attribute Button: This button appears only for multi-valued attributes. Pressing this 
button will pop-up a selection box of all the current values of the attribute for you to choose 
to remove from the set of attribute values.
Select Attribute Button: This button appears only for attributes whose value can only be the 
name of another object, or if the attributes can only have one of the predefined values 
defined by EasyManager.

Buttons

First Button (<<)
Press this button to select the first object of the type for which the form is displayed. For 
example if the Editor is currently displaying the form for Person objects, then the first 
object (determined by sorting all Person objects by name attribute) is selected and 
displayed.

Previous Button (<)
Press this button to select the previous object of the type (for which the form is 
displayed) with respect to the object being edited currently. The previous object is 
determined by sorting all the objects of the type that is being edited by name attribute, 
and then selecting the object that is before the object that is currently being edited. If no
object is being edited currently, then the first object is selected and displayed.

Next Button (>)
Press this button to select the next object of the type (for which the form is displayed) 



with respect to the object being edited currently. The next object is determined by 
sorting all the objects of the type that is being edited by name attribute, and then 
selecting the object that is after the object that is currently being edited. If no object is 
being edited currently, then the last object is selected and displayed.

Last Button (>>)
Press this button to select the last object of the type for which the form is displayed. For 
example if the Editor is currently displaying the form for Person objects, then the last 
object (determined by sorting all Person objects by name attribute) is selected and 
displayed.

Find Box
This is a box where the name of the object being edited currently is displayed. You can 
select an object directly by simply entering the name and pressing return. You may enter
only partial name. If more than one object match the name, then you will be given a 
selection box to make further selection.

Select Button (Sel...)
Press this button to select a object of the type that is displayed in the Object Display 
Area that you want to view or edit.

New Button (New)
Press this button to create a new object of the type that is currently displayed. Pressing 
this button deselects any object that was selected before. This clears and grays out all 
the attribute value boxes except the Name attribute in the Object Display Area. This 
button does not actually create an object. The object is created as soon as you specify 
the name and press return or tab.

Delete Button (Del)
Press this button to delete the object that is currently displayed in the editor. The object 
that is currently displayed, is always the currently selected object.

Close Button (Close)
Press this button to close the EasyEditor. You can also double click on the window's 
system menu in the upper left corner of the window.

Type Button (Type...)
Press this button to change the type of object that you want to view, create, edit or 
delete from the editor. This will display a selection box of all the possible types. Choose a
type by double clicking on one of the selections or clicking once and than clicking the OK 
button.

See Also
Overview of EasyEditor 
Overview of Objects 



Overview of EasyLook

EasyLook allows you to view certain information on Person, Business and Group Objects 
quickly and easily without having to search within one or more EasyList and/or EasyEditor.
You can invoke the EasyLook feature by one of the following ways:

1. Select EasyLook menu item from the Edit menu.
2. Use keyboard shortcut Ctrl+L.
3. Click on the EasyLook icon on the toolbar 

To lookup the desired information, you need to do the following:
1. Select what kind of information you want to lookup. You do this by pressing the 

Setup... button.
2. Enter the search string (partial or full string) that is part of the name of the 

object. You select the search criteria to use for searching within the EasyLook 
Setup Dialog.

3. Press Enter or click on the Look button.
The result is displayed in the result area.
Once the result of your search is displayed, EasyLook does not automatically update the 
result information if you later create, modify or delete objects which can affect the result. 
This is done purposely for performance reasons. You can update the result by redoing the 
search by simply pressing the Look button.

See Also
EasyLook Layout
EasyLook Setup Dialog
Overview of EasyEditor
Overview of EasyList



EasyLook Layout

EasyLook window has the following components:

Result
This is a read-only scrolling area where the result of the lookup is displayed. You can 
scroll up and down the result, select and copy the text to clipboard.

String To Search
Enter the search string that you want to lookup. Search string is used in conjunction with 
the search criteria that you select from the EasyLook Setup Dialog, to look up the desired
information only of the objects whose name attribute matches the search string.

Look
Press this button to look up desired information of objects that satisfy the search string 
using the selected search string criteria.

Setup...
Press this button to display the EasyLook Setup Dialog. Use this dialog box to specify the 
information you want to lookup, and the search criteria to use for filtering objects whose 
information should be displayed.

Close
Press this button to close the EasyLook window.

See Also
Overview of EasyLook
EasyLook Setup Dialog



EasyLook Setup Dialog

EasyLook Setup Dialog is used to customize information you want to look up of a given 
object, and the criteria to use to search for objects for which you want to lookup the desired 
information.

What To Look 
You may look up one or more of the following information on objects:
Postal Address: Select this to lookup Person's home and work address, and Business's 
postal address.
Telephone Number: Select this to lookup Person's home and work telephone numbers, and
Business's telephone number.
Fax Number: Select this to lookup Person's home and work fax number, and Business's fax 
number.
Email Address: Select this to lookup Person's electronic mail address, and Business's 
electronic mail address.
Birth Date: Select this to lookup Person's birth date.
Marriage Date: Select this to lookup Person's marriage date.
Relationships: Select this to lookup Person's father, mother, spouse and children.

Search Criteria To Search For Objects
You specify how to match the search string with the name of the object (Name attribute for 
Person Object, Business Name for Business Object, and Group Name for Group Object). 
Information is looked up only for the objects that match the search string using the criteria 
you specify 
You can specify one of the following match criteria:
Contains: This criteria matches all objects whose name contains the search string.
Begins With: This criteria matches all objects whose name starts with the search string.
Exact: This criteria matches all objects whose name is the same as the search string.
In addition to the above search criteria, you can also choose to ignore case or not ignore 
case while matching the search string. To ignore case, select the Ignore Case option.

See Also
Overview of EasyLook
EasyLook Layout

Person Object
Business Object
Group Object





Overview Of EasyFilter

This feature will be available in a future release.

See Also
Future



Filtering Objects

This feature will be available in a future release.

See Also
Future



Selection Dialog

Selection Dialog is a common dialog that displays a list of choices that you choose from. The
list of choices displayed in the selection dialog box depends on the context. Depending on 
the context, it will display one of the following:

1. Names of the objects i.e. Name attribute of Person object, Business Name 
attribute of the Business object, and/or Group Name of the Group object.

2. Type of object. Currently, there are three type of objects:. Person, Business, 
and Group.

3. Discrete choices for attributes that accept only a pre-defined values, like 
choices Male and Female for Sex attribute of Person object.

To make a selection
1. Double click on the desired selection, or
2. Click once on the desired selection and then press OK button, or
3. Click once on the desired selection and press Return/Enter button.

To scroll through the list of choices:
1. Scroll using scroll keys (Page Up, Page Down, Arrow Up, Arrow Down, Home and  

End), or
2. Press the alphabet key to jump to the next selection that starts with the desired 

alphabet.

To cancel the selection:
1. Press Cancel button, or
2. Press Esc button.

See Also
Overview of Objects
Person Object
Business Object
Group Object

Overview of EasyList
Overview of EasyEditor



Keyboard Shortcuts

There are many keyboard shortcuts that are defined in EasyManager to improve your 
productivity. The following table lists all of them.

Commands
Key Action

Ctrl+N Open A New Document
Ctrl+O Open An Existing Document
Ctrl+S Save An Open Document

Ctrl+D Delete Selected Object
Ctrl+J Jump To Object
Ctrl+E Open EasyEditor
Ctrl+L Open EasyLook
Ctrl+P Print Active EasyList
Ctrl+I Open EasyImport

F1 Help
Shift F1 Context Sensitive Help

Ctrl+X Cut current selection and copy to Clipboard
Ctrl+C Copy current selection to Clipboard
Ctrl+V Paste from Clipboard

EasyList and EasyEditor

Key Action

Up Arrow Activate the cell above the current active cell
Down Arrow Activate the cell below the current active cell
Right Arrow Activate the cell right of the current active cell
Left Arrow Activate the cell left of the current active cell
Page Up Move the active cell one page up
Page Down Move the active cell one page down
Ctrl + Page Up Move the active cell one page to the left
Ctrl + Page Down Move the active cell one page to the right
Home Move the active cell to the first cell in the row
End Move the active cell to the last column that has data, staying 

within the current row
Ctrl + Home Move the active cell to row one, column one
Ctrl + End Move the active cell to the last column that has data, staying 

within the current row



Tab Move to the next cell that can be edited    from the current 
active cell, the order is right, then down

Shift-Tab Move to the previous cell that can be edited from the active cell,
the order is left, then up

Ctrl + X Cut the current selection or cell's data to the clipboard
Ctrl + C Copy the current selection or cell's data to the clipboard
Ctrl + V Paste the clipboard into the current cell location
Enter If editing a cell, signal the end of edit, and move to the next cell

that can be edited, the order is right, then down
Esc If editing a cell, cancel the editing and restore the old cell value
F2 If editing a cell, clear the cell value
F3 If editing a date cell value, the current date will be placed in the

cell
F4 If editing a date cell value, a pop-up calendar will be displayed 

for choosing a date



Feedback

We wish to thank you for using EasyManager For Windows. We at Gupta International are 
committed to make EasyManager For Windows the product of your choice to manage your 
personal information and export the information to other applications as and when you need
it.
Please let us know if you have any problems with the current version of EasyManager, or 
comments or suggestions on how to further improve the product. You can contact us in any 
of the following ways:

1. Send us an electronic mail, our CompuServe address is 71332,167. From 
internet the address is 71332.167@compuserve.com. This is the most 
preferred way.

2. Call us by phone. Our phone number is 408-992-0300. Please leave a message
at the voice mail.

3. Send us a US Mail letter. Our postal address is :
Gupta International
140 Pasito Terrace, #511
Sunnyvale, CA 94086

Please include your name, daytime phone number, electronic mail address if any, product 
version, and the problem, suggestions, or comments that you want to share with us.
Thank you for taking the time to talk to us.



Registering EasyManager

To register EasyManager For Windows, simply fill out the registration form. Registration form 
is provided as a WRITE document which you can view by clicking on the Registration 
Form icon in the EasyManager For Windows Program Group or by simply opening the 
register.wri using the WRITE program, or by simply printing the register.txt file directly. 
Both these files appear under the installation directory for EasyManager For Windows.
Alternatively, you can also register by simply following the following instructions:
To register your copy of EasyManager For Windows, send a check for $15.00 + $2.00 for 
shipping and handling payable to Gupta International at the following address:

Gupta International
140 Pasito Terrace, #511
Sunnyvale, CA 94086.

Please include the following information along with your payment:
1. Name
2. Company Name
3. Postal Address
4. Day Time Phone
5. Day Time Fax
6. Electronic Mail Address

When you register you get a number of benefits.
· You will get the capability to export data to many more applications as they 

become available.
· You will also receive free updates of the software as they are released for at 

least one year including the EasyFilter, and EasyReminder feature.
· Registration is required if you continue to use EasyManager after 30 days from 

the date of installation.



About Gupta International

Gupta International is the developer of EasyManager For Windows. Gupta International 
specializes in consulting and contracting in all aspects of software development including:

· Client/Server Applications
· Object Oriented Databases (ObjectStore)
· Object Technology Re-engineering
· Software Architecture
· Class Libraries
· Localization
· VLSI CAD (Physical)
· UNIX and MS-Windows Platforms
· Offshore & Offsite Development
· C++, C, Visual Basic, PostScript

Please contact Gupta International for your consulting needs as follows:
Gupta International
140 Pasito Terrace, #511
Sunnyvale, CA 94086

Tel: 408.992.0300
Email: 71332.167@compuserve.com



EasyManager Commands Index
Commands

File menu
Edit menu
View menu
EasyList menu
EasyLabel menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print 
EasyList

Prints currently active EasyList.

Print Setup Selects a printer and printer connection.
EasyExport Displays the EasyExport Dialog to export data to other applications.
EasyImport Displays the EasyImport Dialog to import data from other applications.
Exit Exits EasyManager.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data and moves it to the clipboard.
Copy Copies data to the clipboard.
Paste Pastes data from the clipboard.
Delete Object Deletes the selected object from database.
Jump To Object Jumps to the object that is being referred to in the active 

cell in the EasyEditor or EasyList.
EasyEditor Invokes EasyEditor to create, modify and delete objects
EasyLook Invokes EasyLook to quickly lookup specific information
EasyEditor 
Font

Invokes Font Dialog to customize EasyEditor Font

Edit 
Preferences

Invokes Preference Dialog to edit your preferences to 
customize certain aspects of application



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



EasyList menu commands

The EasyList menu offers the following commands:

Lists Displays the names of the currently defined EasyLists that 
can be opened to view, create, modify and delete objects.

Define 
EasyList

Displays the dialog box to define a new EasyList and to 
modify or delete one of the existing EasyList.

EasyList Font Displays the font dialog box to chose a font in which all 
EasyLists will be displayed.



EasyLabel menu commands

The EasyLabel menu offers the following commands:

Labels,... Displays the names of the currently defined 
EasyLabels that can be opened to view, create, modify
and print labels.

Define EasyLabel Displays the dialog box to define new EasyLabels and 
to modify or delete existing EasyLabels.

EasyLabel Font Displays the font dialog box to chose a font in which 
all EasyLabels will be displayed.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new EasyList window that displays the same list 
as the currently active EasyList.

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get 
help.

Using Help Provides general instructions on using help.
Getting Started Offers instructions to quickly learn to start using 

EasyManager.
Registering 
EasyManager

Displays help on how to register your copy of 
EasyManager.

About EasyManager Displays the version and registration information of 
this application.

About Gupta 
International

Displays contact information about the company.



New command (File menu)

Use this command to create a new document in EasyManager.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document .    You can have only one open document. 
If a document is already open, that document will first be closed and then the requested 
document opened. You specify the file to open in the File Open dialog box

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
You can only open files with exc extension

Drives
Select the drive in which EasyManager stores the file that you want to open. 

Directories
Select the directory in which EasyManager stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    EasyManager 
suggests that you save changes to your document before you close it.    If you close a 
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, EasyManager displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, EasyManager displays the Save As dialog box so you 
can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    EasyManager displays the Save 
As dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    EasyManager adds 
the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your EasyManager session.    You can also use the Close command 
on the application Control menu.    EasyManager prompts you to save documents with 
unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible. The name of the command 
changes, depending on what the last action was. The Undo command changes to Can't Undo
on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

This feature not yet available.



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard. This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is unavailable if 
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



EasyEditor Font (Edit menu)

Use this command to select the font to use when displaying the data in the EasyEditor. This 
command displays the Choose font dialog box.

Shortcuts
None



Edit Preferences (Edit menu)

Use this command to specify your preferences to customize certain aspect of application 
behavior. This command displays the Edit Preferences dialog box.

Shortcuts
None



Edit Preferences Dialog

The following preferences can be set to customize the application behavior.

Open Last Opened File On Startup
Check this box if you want EasyManager to automatically open the data file that you had 
opened last time when you ran EasyManager For Windows. If you generally work with 
just one file, than it is convenient to check this option.

Share Home Telephone Numbers When Living Together
Check this box if you want EasyManager to automatically share the home telephone 
numbers amongst persons living together.

If this option is checked, when you change the home telephone numbers of a person, the
change is reflected for all the persons living together. If the option is unchecked, for all 
persons that are living with another person, will not share the telephone numbers.

Share Home Fax Numbers When Living Together
Check this box if you want EasyManager to automatically share the home fax numbers 
amongst persons living together.

If this option is checked, when you change the home fax numbers of a person, the 
change is reflected for all the persons living together. If the option is unchecked, for all 
persons that are living with another person, will not share the home fax numbers.

Share Working Telephone Numbers When Working Together [Not Available]
Check this box if you want EasyManager to automatically share the work telephone 
numbers amongst persons working together. In general if a person is working with 
another person, then company name and the work address is shared between the two 
persons, but the work telephone numbers are not.

If this option is checked, when you change the work telephone numbers of a person, the 
change is reflected for all the persons working together.

Share Work Fax Numbers When Working Together [Not Available]
Check this box if you want EasyManager to automatically share the work fax numbers 
amongst persons working together. In general if a person is working with another person,
then company name and the work address is shared between the two persons, but the 
work fax numbers are not.

If this option is checked, when you change the work fax numbers of a person, the change
is reflected for all the persons working together.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in EasyManager, such as File Open. A check mark appears next to 
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The 
toolbar provides quick mouse access to many tools used in EasyManager,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document. EasyManager displays the Open dialog box, in which you
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, EasyManager displays the Save As dialog box.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Invoke EasyLook to quickly lookup information on objects

Invoke EasyEditor to create, modify and delete objects.

Export data to ASCII files and other applications.

Import data from ASCII files.

Print the active EasyList.

About EasyManager.

Obtain context sensitive help 



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the EasyManager window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Define EasyList (EasyList menu)

Use this command to define a new EasyList, or modify the definition of the existing EasyList 
or to delete the definition of an existing EasyList. This command displays the Define EasyList
dialog box.

Shortcuts
None



Define EasyList Dialog

Define EasyList dialog presents the following options and actions:

Currently Defined Lists
This presents a list of all the EasyLists that are currently defined. To edit an existing 
EasyList, either double click on the desired EasyList or select the EasyList and press the 
Edit List button.

New List...
Press this button to define a new EasyList. This will display the EasyList Editor.

Edit List...
Press this button to edit an existing EasyList. This action is unavailable if no EasyList is 
selected in the Currently Defined Lists box. This will display the EasyList Editor.

Del List...
Press this button to delete an existing EasyList. This action is unavailable if no EasyList is
selected in the Currently Defined Lists box.

Close
Press this button to close the dialog box.

Shortcuts
None



EasyList Font (EasyList menu)

Use this command to select the font to use when displaying the data in the EasyLists. All 
EasyLists are displayed in the chosen font. This command displays the Choose font dialog 
box.

Shortcuts
None



Define EasyLabel (EasyLabel menu)

Use this command to define a new EasyLabel, modify the definition of the existing EasyLabel
or delete the definition of an existing EasyLabel. This command displays the Define 
EasyLabel dialog box.

Shortcuts
None



Define EasyLabel Dialog

Define EasyLabel dialog presents the following options and actions:

Currently Defined Labels
This presents a list of all the EasyLabels that are currently defined. To edit an existing 
EasyLabel, either double click on the desired EasyLabel or select the EasyLabel and press
the Edit Label button.

New Label...
Press this button to define a new EasyLabel. This will display the EasyLabel Editor.

Edit Label...
Press this button to edit an existing EasyLabel. This action is unavailable if no EasyLabel 
is selected in the Currently Defined Labels box. This will display the EasyLabel Editor.

Del Label...
Press this button to delete an existing EasyLabel. This action is unavailable if no 
EasyLabel is selected in the Currently Defined Labels box.

Close
Press this button to close the dialog box.

Shortcuts
None



EasyLabel Font (EasyLabel menu)

Use this command to select the font to use when displaying the data in the EasyLabels. All 
EasyLabels are displayed in the chosen font. This command displays the Choose font dialog 
box.

Shortcuts
None



New command (Window menu)

Use this command to open a new EasyList window with the same contents as the active 
EasyList window.    You can open multiple EasyList windows to display different parts of an 
EasyList at the same time.    If you change the contents in one window, all other windows 
reflect those changes.    When you open a new EasyList window, it becomes the active 
window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

EasyManager displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the name of the active window.    Choose a 
window name from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using EasyManager and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About EasyManager command (Help menu)

Use this command to display the copyright notice, version number, and registration 
information of your copy of EasyManager.



About Gupta International command (Help menu)

Use this command to display information about the company, and means to contact the 
company for suggestions and problems regarding the application, and for offshore and 
offsite consulting.



Context Help command 

Use the Context Help command to obtain help on some portion of EasyManager.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the EasyManager window, such as another Toolbar
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



EasyManager Registration

This dialog is used to view and update registration information.

Name
View/modify the name of the user under whose name the software is registered or will be
registered. A name must be specified.

Company Name
View/modify the company name of the user under whose name the software is registered
or will be registered. Specifying a company name is optional.

Serial Number
View/modify the serial number of the software. The serial number can be specified to be 
zero (0), if you are installing a shareware version or you can specify a registered serial 
number. If you have a shareware version of the software, you can use it for 30 days from 
the date of installation, after which you must register to continue using it. See 
Registering EasyManager for details on how to register your copy of EasyManager.

Update
Press this button to update the registration information.

Cancel
Press this button to cancel any changes you made to the registration information and to 
close the dialog.



Title Bar

The title bar is located along the top of a window.    It contains the name of the window 
indicating the purpose of that window.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button

Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the window. The scroll boxes inside the scroll 
bars indicate the relative position of all the data that you can see in the window.    You can 
use the mouse or the scroll keys to scroll to see the data.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the EasyManager window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    EasyManager determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    EasyManager 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the active window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

Choose Font dialog box is used to specify a font. The dialog box has the following options:

Font:
Presents a list of all the available fonts from which to choose a font from.

Font Style:
Presents a list of the available styles for the currently chosen font.

Size:
Presents a list of possible font sizes for the currently chosen font.

Effects:
Presents the option to underline or to strikeout the currently chosen font.

Color:
Presents a drop-down list of colors to select from for the currently chosen font.

Sample:
This is the area where a sample of how the font would look like if the current font setting 
is selected.



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context id. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context id. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context id. used by this help topic for the 
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>

    



UNKNOWN_PROPERTY

No Help Available



INVALID_CLASS_NAME

No Help Available



NULL_ATTRIBUTE_NAME

No Help Available



ATTRIBUTE_TYPE_MISMATCH

No Help Available



INVALID_ATTRIBUTE_INDEX

No Help Available



NULL_ATTRIBUTE_ARRAY

No Help Available



CIM_UNKNOWN_VERSION

No Help Available



NO_EXPORTDATA

No Help Available



CIM_READ_ERROR

No Help Available



EXPORT_SUCCESS

No Help Available



CIM_WRITE_ERROR

No Help Available



OPEN_FAILED

No Help Available



CIM_EXTRACTION_FAILED

No Help Available



RENAME_FAILED

No Help Available



CYCLE

No Help Available



WILL_FORM_CYCLE

No Help Available



ERROR

No Help Available



EACCES

No Help Available



EIO

No Help Available



ENOTDIR

No Help Available



INVALID_COL_DEF

Column definition is not valid. The colum definition will be ignored



PRIMARY_COL_IS_FIXED

No Help Available



NO_OBJECT_CLASS

No Help Available



UNKNOWN_CLASS_NAME

The class name (object type) specified is not known or is empty, edit the list and specify a 
valid class (object type).



CREATE_FAILED

Failed to create the desired object within the database. Most probably you have insufficient 
memory. Close some other applications and try again.



NO_COL_CHOICE

You have not selected an attribute to display in the specified column. You must either select 
an attribute, or delete the column.



EMPTY_LIST_NAME

No Help Available



CANNOT_JUMP_WHEN_EDITING

No Help Available



OBJECT_BY_KEY_DOES_NOT_EXIST_CREATE_OK

No Help Available



INVALID_CLASS_NAME

No Help Available



INVALID_ROW

No Help Available



NO_OBJECT_FOR_ROW

No Help Available



CREATE_DUPLICATE_KEY_OBJECT

No Help Available



EDIT_PRIMARY_COLUMN_FIRST

No Help Available



INVALID_VALUE

No Help Available



ATTRIBUTE_CANNOT_BE_NULL

No Help Available



INVALID_COLUMN

No Help Available



CANNOT_JUMP_OBJECT_NOT_IN_LIST

No Help Available



KEY_OBJECT_EXISTS_RENAME

No Help Available



GET_ALL_OBJECTS_FAILED

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



GET_INDIRECT_ATTRIBUTE_FAILED

No Help Available



UPDATE_ATTRIBUTE_FAILED

No Help Available



OBJECT_CREATE_FAILED

No Help Available



NO_DATA

No Help Available



UNKNOWN_CLASS

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



GET_INDIRECT_ATTRIBUTE_FAILED

No Help Available



SYNTAX_ERROR

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



OBJECT_CREATE_FAILED

No Help Available



UPDATE_ATTRIBUTE_FAILED

No Help Available



CREATE_DUPLICATE_VALUE_OBJECT

No Help Available



NULL_ENUMERATOR_ARRAY

No Help Available



NULL_ENUMERATOR_NAME

No Help Available



INVALID_ENUM_NAME

No Help Available



NULL_FILE_NAME

No Help Available



SEEK_FAILED

No Help Available



PARSE_ERROR

No Help Available



READ_FAILED

No Help Available



CLASS_PROPERTY_DEFINITION_FAILED

No Help Available



OPEN_FAILED

No Help Available



ATTRIBUTE_PROPERTY_DEFINITION_FAILED

No Help Available



ENUM_DEFINITION_NOT_IN_PROGRESS

No Help Available



OBJECT_DEFINITION_NOT_IN_PROGRESS

No Help Available



CLASS_DEFINITION_IN_PROGRESS

No Help Available



CLASS_DEFINITION_NOT_IN_PROGRESS

No Help Available



OBJECT_DEFINITION_IN_PROGRESS

No Help Available



ENUM_DEFINITION_IN_PROGRESS

No Help Available



NULL_INDIRECT_ATTRIBUTE

No Help Available



INDIRECT_ATTRIBUTE_NOT_POINTER

No Help Available



GET_INDIRECT_ATTRIBUTE_FAILED

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



SET_ATTRIBUTE_FAILED

No Help Available



INVALID_ATTRIBUTE_INDEX

No Help Available



INDIRECT_ATTRIBUTE_PATH_TERMINATED

No Help Available



OK_TO_DELETE

No Help Available



ANCESTOR

No Help Available



LIVING_WITH_HEAD_OF_HOUSEHOLD

No Help Available



SEX_UNDEFINED_IS_MALE

No Help Available



LIVING_WITH_SOMEONE_ELSE

No Help Available



WORKING_WITH_SOMEONE_ELSE

No Help Available



SEX_MISMATCH

No Help Available



LIVING_WITH_ONESELF

No Help Available



WORKING_WITH_ONESELF

No Help Available



INVALID_PARTS

No Help Available



OBJECT_BY_KEY_DOES_NOT_EXIST_CREATE_OK

No Help Available



CANNOT_JUMP_WHEN_EDITING

No Help Available



ENTER_KEY_ATTRIBUTE_VALUE_FIRST

No Help Available



KEY_ATTRIBUTE_CANNOT_BE_EMPTY

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



UPDATE_ATTRIBUTE_FAILED

No Help Available



CONVERSION_TO_ATTRTYPE_FAILED

No Help Available






